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Key Summary of the E-Filing Process

This summary shows you the steps involved to E-File your data.
Whatever you E-file, the steps remain the same

• RTI – FPS, EPS, FSY, NVR & EYU

Step 1 Sign Up/Sign In.

Step 2 Download  the  given  spreadsheet  template  from  our
website 

Step 3 Populate  the  data  from  your  system  into  the  given
spreadsheet.

Step 4 Assign a file name to the spreadsheet and save it in a CSV
file format.

Step 5 Sign in to the website and select Upload CSV File from the
top menu bar.

Step 6 Click on the Browse button to find the CSV file that you
just assigned a name to and then upload the same CSV
file.

Step 7 E-file  the  uploaded  file  by  clicking  on  E-File  Now!,  or
amend  the  file  based  on  the  error  report  provided  and
upload the file again.

Step  8 Print the E-filing Certificate and view reports.

( More information about each of the steps is detailed below. )

Support  Email:   Support@eFileReady.com       Tel:  020 8452 9516
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 1 Conducting RTI Tests (How To)
The RTI Test service is now available on the citytest.efileready.com LIVE E-FILING TEST site. 

To test  the  RTI  services,  you  have  to  sign  up  with  us.  The  sections  below  will  help  you  to
understand the steps involved in creating a TEST account and E-filing the RTI returns to HMRC
from CityeFileReady. 

 1.1 Where and How to Sign Up for a LIVE TEST Account

To create a Test Account on CityeFileReady, go to  citytest.efileready.com, and click on the red
'Click here for RTI & Other E-Filing Tests' button.

Fig 1.1  Click on the pink button to create a Live Test E-Filing Account
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Alternatively, click on the following link – citytest.efileready.com. Then click on Sign Up and follow
the screens to sign up for a test account.  You will receive an E-Mail containing an activation link.  

Click on the link within the e-mail and set up your sign in details for your test account  After your
test account has been created, sign In to the TEST account from the link citytest.efileready.com.

Fig 1.2  Developer Live Test Site ( citytest.efileready.com ) - Click on  Sign Up 

Road Map:

Click on activation link -> Set up your Sign In security details (password, pattern word etc.) -> Final
Confirmation

After a successful sign up process, you can sign in to the account with your credentials - User ID, 
E-Mail, Password and Pattern word. Each time you sign in, you will be asked to enter your Sign In 
credentials.

 1.2 Test Credentials Set Up for E-Filing

 1.2.1 Test Credentials Set Up

• By default  CityeFileReady  has pre-entered CityeFileReady's  own  HMRC Agent  ID and
Password ready for you to use to E-File your test RTI forms including FPS, EPS, NVR. You
do not need to use your own PAYE credentials.
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• To view CityeFileReady's own test credentials,  go to Employer/Contractors in the tasking
zone menu bar and click on E-filing Credentials Setup. Further click on the 'HMRC RTI
FPS, EPS, NVR' link. On the next page, by default the CityeFileReady's Agent Credentials
will be provided as shown in Fig 1.2.1

Fig 1.2.1  CityeFileReady Default Test Credentials

 1.2.2 Using your own Software Developer Test Credentials

Your own Software Developer Test credentials obtained from HMRC can be used for testing the 
RTI E-filing services of CityeFileReady. To apply for your own Test Credentials please contact the  
Software Developers Support Team (SDS Team).  

To  set  up  your  own  Software  Developer  test  credentials  in  CityeFileReady,  go  to
Employer/Contractors  on  the  tasking  zone  menu bar  and  click  on  E-filing  Credentials  Setup.
Further click on the 'HMRC RTI FPS, EPS, NVR' link.
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• Then  select   'I  am  an  Employer'  (see  fig  1.2.2)  or  'I  am  an  AGENT  /  BUREAU'  as
appropriate  and  enter  your  Software  developer  Test  credentials  (HMRC  User  ID  and
password) provided by HMRC by clicking on the Edit button and later on the save button.

• Alternatively, you can use the following test credentials for Submission of FPS, EPS, NVR
etc

PAYE Reference :     548 / A548 ( to be included in the FPS or EPS file )
User ID   :                  ISV548
Password  :               testing1 

Fig 1.2.2  Software Developer Company / Agent Test Credentials
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 1.3 How to download the RTI Spreadsheet 

Download the spreadsheets for the respective RTI returns. Save them all as CSV files and further 
proceed with uploading the files. The upload process is explained in detail in the further sections.

NOTE : The guide remains same for all RTI forms including FPS, EPS, EYU & NVR 

To download the PAYE RTI FPS, EPS, NVR, FSY & EYU Data spreadsheets to your local system,
please follow the road map below.

Road Map:

Download Spreadsheet  →  'PAYE RTI FPS, EPS, NVR,  FSY, Additional  FPS, EYU Template
Download'

Fig 1.3.1  Download the RTI Test Data Spreadsheet -  PAYE RTI  FPS, EPS, NVR & EYU
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Fig 1.3.2  Click on Download Spreadsheet- RTI  2018-19 Full Payment Submission

Fig 1.3.3  Click to download the spreadsheet
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Now, click on the 'Download PAYE RTI FPS Spreadsheet' link to download the FPS spreadsheet 
to your local system. 

Please follow the same steps to download the EPS, EYU, NVR & FSY spreadsheets to your 
system.

 1.4 How to Upload the RTI Files

 1.4.1 Select Upload CSV/GFF/XML File from the menu bar 

Sign in to citytest.efileready.com . Go to Upload Data on the tasking zone menu bar to upload the 
test data. Please follow the below road map to upload RTI test files.

Road Map :

Upload Data →  Upload RTI FPS, EPS, NVR, FSY, Additional FPS, EYU

Fig 1.4.1 Click on Upload Data 
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Now click on the appropriate Upload RTI CSV/GFF/XML File link. For example, click  'FPS CSV 

File' Link to upload the FPS CSV file.

Fig 1.4.2 Click on the appropriate Upload CSV File link

 1.4.2 Browse to find the CSV file and then upload that CSV file

Enter the Employer name and pick up the FPS CSV spreadsheet file you just saved in your local 
system by clicking on the 'Browse' button (in just the same way as you sign in to an e-mail account
and then go to your local system to pick up a file you prepared previously to attach to an e-mail). 

Enter a reference of your choice for the CSV file you are uploading. This is optional, you can leave 
it blank.

Now click on the 'Upload CSV File' button to upload the file to the City Test efileready server.

NOTE : Do not click on the screen while the upload is in progress because it might interrupt the 
upload.

© Copyright Intersoftware Solutions Limited. Page  11 of  31  



CityeFileReady RTI User Manual – How CityeFileReady Works

 Fig 1.4.3  Browse to find the files and then click on the Upload CSV File button

As you upload your CSV files, our service instantly converts the files into XML and validates them 
against the HMRC provided SCHEMA and BUSINESS RULES, ready for E-filing.

If no errors are found in the uploaded data, you will see a successfully uploaded message on the 
screen as shown in fig 1.4.4.
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Fig 1.4.4 CSV Data Upload Report

If errors are found, an Error Report will be displayed on screen as shown in  fig 1.4.5. You should 
amend the errors as indicated and then start the process again.

Fig 1.4.5  CSV Data Validation Error Report

Please follow the same process as above to upload RTI EPS, EYU, NVR & FSY spreadsheets to 
CityeFileReady.
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 1.5 How to E-File RTI Data to HMRC

 1.5.1 E-Filing the uploaded RTI-  FPS, EPS, NVR, FSY & EYU Data to HMRC

To E-File your uploaded RTI data to HMRC, go to E-filing on the tasking zone and click on 'E-File
PAYE RTI FPS, EPS, NVR, FSY, Additional FPS, EYU'.

Road Map:

E-filing →  E-File PAYE RTI FPS, EPS, NVR, FSY, Additional FPS, EYU

Fig 1.5.1  Click on the E-File RTI FPS, EPS, NVR, FSY, Additional FPS, EYU 

   

Further click on the E-File FPS (Full Payment Submission) Uploaded Data link to E-File the PAYE
RTI FPS data.
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Fig 1.5.2  View the data to be E-filed

Before E-filing your data to the HMRC, you should double check to ensure that the data you have 
uploaded is correct.  To  view and check the uploaded data before E-filing, simply click on the View
/ Print link. If the upload is correct, select the upload you wish to e-file by selecting the appropriate 
box, then click on the 'E-file Now!' button. Enter your name and sign in password in the Employer's 
Declaration page. 
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Fig 1.5.3  Enter your details on the Declaration page
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The below screen will be displayed as your data is being sent to the HMRC. There may be a  delay
before you receive a response from the HMRC, especially at peak times.

Fig 1.5.4  E-Filing in progress

Please note, the E-filing done on the CityTesteFileReady server is only for Testing purposes. You 
cannot e-file your actual Live Returns through City Test eFileReady. To e-file your actual returns to
HMRC, please sign up for our Live CITY-eFileReady account on cityrti.efileready.com
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 1.6 How to Check the E-Filed Status

Once the data is submitted to HMRC an E-Filing Certificate is generated from HMRC which you
can view in the Reports section.

Road Map : 

Reports →  View/Print Your E-Filed Returns and Others

Fig 1.6.1  E-Filing Status

Fig 1.6.1 displays the status of your E-filing of data to HMRC. The status can be Initiated, 
Processing, Submitted and Completed.  Please keep checking the status.

If you get an authentication failure, please check your test credentials, correct them and e-file once
again. Please follow the same steps as explained above for successful E-Filing. To view the E-
Filed certificate, click the View / Print link under the E-Filed Certificate. 
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Fig 1.6.2  E-Filing Certificate
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 2 Conducting  RTI  Live Submissions

 2.1 Where and How to Sign Up for a RTI Live Account 

Click on the following  link  cityrti.efileready.com to sign up for a Live account.  

 2.1.1 Live Credentials Set Up

CityefileReady's own E-filing credentials are pre-entered and selected by default ready for you to 
use to E-File your RTI forms live.

However, if you wish to use your own details,  go to Employer / Contractors on the tasking zone 
and click on E-filing Credentials Setup. Further click on the 'HMRC RTI FPS, EPS, NVR, EYU ' 
link, and select either 'I am an EMPLOYER' or 'I am an Agent / Bureau' to enter your own HMRC 
ID and Password credentials provided by HMRC.

 2.1.2 How to E-file Live RTI Files to HMRC

1. Please download the RTI Spreadsheets - FPS, EPS, NVR from Download Spreadsheet in
the tasking zone.

2. Populate  your  data  into  the spreadsheet  and save the file  in  a CSV/GFF/XML format
locally to your system. 

3. The rest of the process for uploading CSV/GFF/XML files, E-filing the uploaded RTI data to
HMRC and checking the success status remains the same as in RTI Test E-filing. Please
refer to section    1.4     How to Upload the RTI Files section and 1.5     How to E-File RTI Data to
HMRC  .
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 3 How CityeFileReady helps with filing the RTI Submissions 
to HMRC online 
The RTI E-filing process has been simplified in the CityeFileReady application. We have tested
against the available HMRC's RTI TEST Server and the BACS system, and so far all tests have
been successful. We are ready and able to give you all the help and support you need when you
come to fulfilling the HMRC's RTI requirement.

Using CityeFileReady you can E-File the RTI returns to HMRC using a simple spreadsheet. All you
need to do with  RTI is  to  extract  the data from your  payroll  system and place it  in  a simple
spreadsheet template provided by us. Different RTI returns require different spreadsheet templates
which are all freely available from our website.  Our cityrti.efileready.com/ system will convert your
spreadsheet (CSV or GFF file) into the HMRC's required XML format and then e-file your RTI data
automatically. Our system will also automatically produce BACS files embedded with 4 Character
Random Strings and FPS files embedded with correlated HASH CODES.

Our RTI system is fully tested and ready to go. You can test it against the HMRC's TVPS test
server or your BACS system today. As the system is platform independent it will work seamlessly
with whatever payroll or BACS system you have. 

 3.1 RTI Submissions supported by CityeFileReady 

 3.1.1 Full Payment Submission (FPS)

You need to make an FPS return whenever you make a payment to an employee, be it monthly, 
weekly, 2 weekly or 4 weekly etc.  Each pay frequency has its own respective FPS return.  

Unique Services:

CityeFileReady will provide a BACS file with the 4 character random string entered, and where 
supported, the corresponding HASH CODE for FPS, all of which are based on HMRC 
specifications.

The Full Payment Submission ((FPS) will have the HASH CODE ( including the 4-character 
random string ) as required by HMRC.

Fig 3.1.1 Full Payment Submission
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 3.1.2 Employer Payment Submission (EPS)

This is a monthly return submitted when claiming from HMRC for Statutory Payments to 
Employees, CIS Deductions Suffered and other claim items.

Fig 3.1.2 Employer Payment Submission

 3.1.3 NINO Verification Service (NVR)

This allows employers to validate or obtain a new employee NINO.  Simply download the template 
from cityrti.efileready.com and then upload it back to CityeFileReady to e-file the details.  After E-
filing you need to log on to cityrti.efileready.com to view and/or download the responses from 
HMRC. The process is conducted through something known as the Data Provisioning Service 
(DPS).  You can download the response in a CSV or GFF or XML file format to upload directly to 
your system to update your employees' NINO.

Fig 3.1.3 NINO Verification Service

 3.1.4  Earlier Year Update (EYU)

You can submit an Earlier Year Update(EYU) to correct FPS information for up to six years after
you filed your original FPS. If you are correcting an error in a previous tax year when you used
FPS, your EYU should only record the difference between what you had originally submitted and
what the figure should be. For example, if you recorded £100 on an employee's payroll record, the
EYU should show '+£100'. You can only amend year to date data on an EYU.
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 3.2 Correction of Error Data

If you have noticed any errors in the data you have already e-filed, you can update the data with
correct values and re-submit to HMRC via CityeFileReady. Whether you have made mistakes in
FPS or EPS, there are solutions to rectify those and e-file once again. The correction procedures
are different for current tax year data and previous tax year data.

 3.2.1 Current Tax Year Data Correction

 3.2.1.1 Correction of FPS Data using Additional FPS

An Additional FPS return is an extra FPS you may file, in addition to the regular FPS file you have
just completed, to rectify any errors you may have just discovered. The purpose is for you to make
up any under payment, or cancel a payment, or rectify any over payment you may have just made.
It is to be used under the following strict conditions :

• It can be used only when the error of under payment, cancelled payment, or over payment,
is discovered when you are still in the same pay period in which the error was made.

• It can only be used if you are in the new pay period but you have not yet e-filed the FPS file
of  the new pay period,  ie  you  are allowed to rectify immediate  past  pay period errors
provided the current pay period FPS file has not yet been filed.

• You can NOT use it to amend errors that occurred more than one pay period ago, e.g. if
you are in month 7 you definitely can NOT use an Additional FPS to amend any data errors
that occurred in pay period 5 or earlier.

• Errors which occurred more than one pay period ago can be left alone so long as in the
next  FPS  return  you  bring  all  the  payment  and  YEAR  TO  DATE  data  up  to  date.
Alternatively  you  may file  an  Earlier  Year  Update  if  the  errors  occurred belong  to  the
previous tax year.

Please follow the below road maps to e-file the additional FPS to HMRC.

Road Map : Download Additional FPS Spreadsheet

Download  Spreadsheet  → PAYE RTI  FPS,  EPS,  NVR,  FSY,  Additional  FPS,  EYU Template
Download → Download Spreadsheet - Additional FPS Returns → Download PAYE RTI Additional
FPS Returns Spreadsheet 

Road Map : Upload Additional FPS Spreadsheet

Upload Data →  Upload RTI FPS, EPS, NVR, FSY, Additional FPS, EYU  →  Additional FPS
Return (CSV/ EDI GFF / XML) →  Browse → Upload File

Road Map : E-File Additional FPS

E-Filing → E-File PAYE RTI FPS, EPS, NVR, FSY, Additional FPS, EYU → E-File Additional FPS
(Full Payment Submission) Uploaded Data → Select the File → E-File Selected → Enter User
Sign In Password →  E-File Now
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 3.2.1.2 Correction of EPS Data (Current Tax Year)

EPS data e-filed in the current tax year can be corrected by e-filing another EPS to HMRC. The
latest EPS values will overwrite the wrong figures e-filed before.

 3.2.2 Previous tax year data correction

 3.2.2.1 Correction of FPS Data using EYU

You can submit an Earlier Year Update (EYU) to correct FPS information for up to six years after
you filed your original FPS. If you are correcting an error in a previous tax year when you used
FPS, your EYU should only record the difference between what you had originally submitted and
what the figure should be. For example, if you recorded £100 on an employee's payroll record, the
EYU should show '+£100'. You can only amend year to date data on an EYU.

Road Map : Download EYU Spreadsheet

Download Spreadsheet  →  PAYE RTI FPS, EPS, NVR, FSY, Additional  FPS, EYU  Template
Download → Download Spreadsheet - RTI EYU (Earlier Year Update) → Download PAYE RTI
EYU (Earlier Year Update) Spreadsheet 

Road Map : Upload EYU Spreadsheet

Upload Data → Upload RTI FPS, EPS, NVR, FSY, Additional FPS, EYU → Earlier Year Update
(EYU)(CSV/ EDI GFF / XML) → Browse → Upload File

Road Map : E-File EYU Data

E-Filing → E-File PAYE RTI FPS, EPS, NVR, FSY, Additional FPS, EYU  → E-File EYU (Earlier
Year  Update)  Uploaded  Data →  Select  the File  →  E-File  Selected →  Enter  User  Sign In
Password →  E-File Now

 3.2.2.2 Correction of EPS Data (Previous Tax Year)

EPS data e-filed in the previous tax year can be corrected by e-filing another EPS to HMRC. The
latest EPS values will overwrite the wrong figures e-filed before.

 3.3 RTI HASH and BACS

The HASH including random string is a cross reference which will allow HMRC to match the RTI
data received with payments made via BACS. 

There are two parts to the cross-reference:

(a) a hash (including random string) in the RTI FPS submission to HMRC;

(b) a random string inserted in field 7 of the BACS payment instruction.

Employers paying their staff using Bacstel-IP must include a HASH (including random string)  in
their RTI FPS submission. The associated random string must be included in their BACS payment
instructions.
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 3.4 How CityeFileReady generates the HASH Code

CityeFileReady will automatically produce BACS files embedded with 4 Character Random String
and FPS files embedded with correlated HASH (including random string). Later HMRC can then
match  the  hashes  returned  with  the  RTI  data  against  hashes  generated  during  payment  file
processing for compliance cross checking purposes.

CityeFileReady  provides the below options for BACS HASH Code submissions in RTI FPS returns
to HMRC. 

• If the Payroll Software generates the BACS HASH (including random string), they can be
entered in to the FPS spreadsheet.

Then there is no requirement to enter Bank Details for the Employer and Employee. This
can be advantageous to some Employers with particular requirements.

• If CityeFileReady is to be used for generating BACS as well as the FPS files, then all the
BACS related columns should be populated. The below mentioned columns must be filled
in the FPS spreadsheet.

• Employer BACS Service User Number

• Employer Name in Bank Account

• Employer Bank Sort Code

• Employer Bank Account No

• Employee Name in Bank Account

• Employee Bank Sort Code

• Employee Bank Account No

• BACS Payment Description

Please note, once the file has been successfully uploaded,  you can then download the BACS
output file. Currently the default BACS output is in Standard 18 format.

Other BACS Output Formats that can be Supported are :-

1. NatWest Bulk List

2. ALBANY Standard

3. NatWest / RBS Standard

4. Barclays BIB - CSV

5. HSBCnet

6. TransGlobal BACS
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 4 Download notices from the HMRC's DPS (How it works)
Other than E-filing services,  citytest.efileready.com can also be used to download your P6, P9,
SL1,  SL2 etc. (CSV/GFF) documents from the HMRC's Data Provisioning Service (DPS). This
allows you to conduct auto tax code updates.

The HMRC DPS Server allows users to download their data in two different approaches :

• Ongoing Incremental Approach

• Date Defined Approach

Our system has been tested and certified to work perfectly with both approaches.

• Ongoing Incremental Approach:

This allows you to download your respective notices in an ongoing basis. i.e. only the new and
latest  notices  will  be  downloaded  each  time  you  give  it  an  instruction.  The  CIityeFileReady
Gateway Server has incorporated this design into its software architecture, helping you to store
whatever you downloaded previously in its server in an orderly manner. You can view and print
your historical notices at anytime for up to 3 years over the net.

• Date Defined Approach:

You  can  retrieve  your  current  and  historical  data  from  the  HMRC  Server  by  entering  your
requirement into the CityeFileReady Gateway Server. Should your system crash, you need not
worry because you can always retrieve the data again from the DPS. The CityeFileReady Gateway
Server allows you to retrieve your data from any historical period in the current tax year.

The range of documents that can be downloaded include:

– P6, P9 Tax Code Change Notification

– NINO and RTI Notification

– CIS Notification

– SL1, SL2

– NOT – P11(b) Notification

– AR 

– Generic Notifications

For better understanding about how to download notices from HMRC's DPS via CITY-eFileReady,
please follow the step by step guidance  below.
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 4.1 Download DPS Notices

In order to access any DPS (Data Provision Service) services, you must be registered with the
HMRC for PAYE Online Services.  If you do not have HMRC User ID and Password, you need to
apply for them. Click here to apply for HMRC e-filing credentials.

Please follow the below road map to download DPS notices in CityeFileReady.

Road Map:

DPS →  DPS for P6,P9,SL1,SL2,NINO & RTI → Select the appropriate notice → Login to HMRC

Fig 4.2.1 View / Download DPS Notices

 4.2 Log in to HMRC DPS

Now you can enter the HMRC DPS credentials to download the latest notices from HMRC.

For downloading the Data Provisioning Service (DPS) Test notices (Tax Codes and SL1, SL2 etc)
you can use the following test credentials.

PAYE Reference :     123 / A6

User ID   :                  ISV548

Password  :               testing1
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Fig 4.2.2 Login to HMRC

 4.3 View / Download DPS for P6, P9, SL1, SL2, NINo and RTI

Through CityeFileReady, you can download your P6, P9, SL1 and SL2 as well as other available
forms, from the HMRC DPS.  You will be able to download only the latest notices i.e. those which
have not been downloaded before. You can download these files in a GFF format and CSV format,
to conduct auto-tax code updates. 

Road Map:

Select  Form → Click on Confirm Download → View /  Download ongoing notices → Click on
Download ( CSV or EDI GFF)
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Fig 4.3.1 Confirm Download

Fig 4.3.2 Download Ongoing Status
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Fig 4.3.3 Download HMRC Notices

NOTE :  You will  receive  a  reminder  called  a generic  notification from HMRC for  your  late
reporting, late payments and NVR Returns. Through CityeFileReady you can also view/download
RTI Generic notifications. These notifications can be downloaded in GFF format.  Click here for
more information.

Click on the View/Print link under 'GEN NOT Details' to download the generic notification.

Fig 4.3.4 Generic Notification
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4 Other E-Filing Services 
( Automated E-filing to HMRC at anytime over the Internet )

 

1.   Data Provisioning Services (DPS) Downloading

2.   E-filing of P11D, P11D(B), P46(CAR)

3.   E-Filing RTI Returns (FPS, EPS, NVR, FSY & EYU)

Click here to log on to citytest.efileready.com

(For more information about our products and services, please contact our Support Team.)

Support  Email:   Support@eFileReady.com        Tel:  020 8452 9516 

https://citytest.efileready.com/
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